Copyright
Copyright © 2009 Intuit Inc.
All rights reserved.

STATEMENTS IN THIS DOCUMENT REGARDING THIRD-PARTY STANDARDS OR SOFTWARE ARE BASED ON INFORMATION MADE AVAILABLE BY THIRD PARTIES. INTUIT AND ITS AFFILIATES ARE NOT THE SOURCE OF SUCH INFORMATION AND HAVE NOT INDEPENDENTLY VERIFIED SUCH INFORMATION. THE INFORMATION IN THIS DOCUMENT IS SUBJECT TO CHANGE WITHOUT NOTICE.

Trademarks and Patents
Intuit, the Intuit logo, QuickBooks, QuickBase, Quicken, TurboTax, ProSeries, Lacerte, EasyStep, and QuickZoom, among others, are registered trademarks and/or registered service marks of Intuit Inc. in the United States and other countries. Other parties’ trademarks or service marks are the property of their respective owners and should be treated as such. Features and services within QuickBooks products may be the subject matter of pending and issued U.S. patents assigned to Intuit Inc.

Other Attributions
The Regex Library contained in QuickBooks software is copyright 1992, 1993, 1994, 1997 Henry Spencer. All rights reserved. The Regex Library software is not subject to any license of the American Telephone and Telegraph Company or of the Regents of the University of California.

This product includes software developed by the Apache Software Foundation (www.apache.org). © 1999-2006 Apache Software Foundation. All rights reserved.

Important
Terms, conditions, features, service offerings, prices, and hours referenced in this document are subject to change without notice. We at Intuit are committed to bringing you great online services through QuickBooks. Occasionally, we may decide to update our selection and change our service offerings, so please check www.quickbooks.com for the latest information, including pricing and availability, on our products and services.
## Contents

### Welcome

<table>
<thead>
<tr>
<th>Audience of This Guide</th>
<th>5</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical Support</td>
<td>5</td>
</tr>
</tbody>
</table>

### Chapter 1. Learning Enterprise Solutions

<table>
<thead>
<tr>
<th>Getting Around Enterprise Solutions</th>
<th>8</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Home Page</td>
<td>8</td>
</tr>
<tr>
<td>Finding Your Data in the QuickBooks Centers</td>
<td>10</td>
</tr>
<tr>
<td>Getting a Real-Time View of Your Business</td>
<td>12</td>
</tr>
<tr>
<td>Displaying Multiple Windows</td>
<td>12</td>
</tr>
<tr>
<td>Adding Icons to the Icon Bar</td>
<td>13</td>
</tr>
<tr>
<td>Getting Answers to Your Questions</td>
<td>14</td>
</tr>
<tr>
<td>Using In-Product Help</td>
<td>15</td>
</tr>
<tr>
<td>Using the Learning Center</td>
<td>18</td>
</tr>
<tr>
<td>Using the QuickBooks Coach</td>
<td>18</td>
</tr>
<tr>
<td>Using the Live Community</td>
<td>19</td>
</tr>
</tbody>
</table>

### Enterprise Solutions Basics

| Working with Lists                  | 20 |
| Writing Checks Versus Paying Bills  | 21 |
| Using Multiple Currencies           | 22 |
| Using the Sample Company Files      | 23 |
# Chapter 2. Setting Up Your Business

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customizing Enterprise Solutions</td>
<td>26</td>
</tr>
<tr>
<td>Adding an Account</td>
<td>28</td>
</tr>
<tr>
<td>Adding Subaccounts</td>
<td>29</td>
</tr>
<tr>
<td>Creating Brand New Accounts</td>
<td>29</td>
</tr>
<tr>
<td>Account Types</td>
<td>29</td>
</tr>
<tr>
<td>Income and Expense Accounts</td>
<td>30</td>
</tr>
<tr>
<td>Balance Sheet Accounts</td>
<td>31</td>
</tr>
<tr>
<td>Adding Customers</td>
<td>33</td>
</tr>
<tr>
<td>Adding Vendors</td>
<td>35</td>
</tr>
<tr>
<td>Adding Items</td>
<td>36</td>
</tr>
<tr>
<td>Why are Item Types Important?</td>
<td>39</td>
</tr>
<tr>
<td>Setting Up Sales Tax</td>
<td>40</td>
</tr>
<tr>
<td>Understanding How Sales Tax Works</td>
<td>40</td>
</tr>
<tr>
<td>Before You Start Setting Up Sales Tax</td>
<td>41</td>
</tr>
<tr>
<td>Setting Sales Tax Preferences</td>
<td>43</td>
</tr>
<tr>
<td>Setting Up Sales Tax</td>
<td>43</td>
</tr>
<tr>
<td>Part 1: Sales Tax Payment Schedule</td>
<td>44</td>
</tr>
<tr>
<td>Part 2: Setting Up Sales Tax Codes</td>
<td>45</td>
</tr>
<tr>
<td>Part 3: Sales Tax Items, Rates, and Tax Agencies</td>
<td>46</td>
</tr>
<tr>
<td>Entering an Opening Balance for Sales Tax Liability</td>
<td>48</td>
</tr>
<tr>
<td>Setting Up Payroll</td>
<td>49</td>
</tr>
<tr>
<td>Choosing a Payroll Service</td>
<td>49</td>
</tr>
<tr>
<td>Preparing Payroll Information</td>
<td>50</td>
</tr>
</tbody>
</table>
Setting Up Employees ......................................................... 52

Chapter 3. Money In

Creating an Estimate ......................................................... 56
Creating an Invoice ............................................................ 58
Entering Sales Receipts ....................................................... 59
Receiving Payments .......................................................... 60
Making Deposits ............................................................... 61

Chapter 4. Money Out

Paying Bills ........................................................................ 64
Writing Checks ................................................................. 66
Issuing Credits or Refunds .................................................. 67
Paying Employees .............................................................. 68
Intuit Payroll Services ....................................................... 69

Chapter 5. Managing Your Business

Using Reports ..................................................................... 72
Memorizing a Report ......................................................... 73
Customizing a Report ........................................................ 75
Additional Services and Solutions ....................................... 76
Integrated Business Software ............................................. 77

Appendix A. Frequently Asked Questions

How do I register my copy of Enterprise Solutions? ............... 79
How do I contact Technical Support? .................................................. 79
How do I purchase additional user licenses? ................................. 79
How do I move my company file from one computer to another? ....... 80
How do I remove older or unneeded transactions from my data file? .... 81
How do I download and install an update or patch? ......................... 82
How do I back up or restore my company file? .............................. 82
What should I do if I forget my password? ..................................... 83
How do I update my payroll to use the latest tax tables? ................. 84
How do I add another company’s EIN to existing Payroll subscription? . . 84

Appendix B. Keyboard Shortcuts  87

Index  91
Welcome

Welcome to QuickBooks Enterprise Solutions financial software. Use this guide to learn how to use QuickBooks Enterprise Solutions and perform essential tasks.

To install and set up Enterprise Solutions, refer to the *QuickBooks Enterprise Solutions Installation and Setup Guide*.

**Audience of This Guide**

The *QuickBooks Enterprise Solutions User Guide* has been prepared for accounting and business management professionals who manage business finances, inventory, customers, vendors, and employees.

**Technical Support**

Visit our Support website at [www.qbes.com/support](http://www.qbes.com/support) for support options and answers to frequently asked questions. Enterprise Solutions offers a Full Service Plan\(^1\) (sold separately) that includes product upgrades, technical support, training tools, and data protection services. Intuit reserves the right to limit each telephone contact to one hour and to one incident. Additional terms and conditions apply.

You can also visit the QuickBooks Enterprise Solutions User Community at [www.qbes.com/community](http://www.qbes.com/community) to connect with other Enterprise Solutions users and experts to ask questions and share advice.

---

1. The Full Service Plan is good for 12 months from your QuickBooks Enterprise Solutions purchase date or Full Service Plan renewal date. The Intuit support team is available weekdays from 4 A.M. - 7 P.M. Pacific time. Intuit reserves the right to limit each telephone contact to one hour and to one incident. Support availability subject to occasional downtime for systems and server maintenance, company events, observed U.S. holidays, and events beyond our control. Terms, conditions, pricing, service offerings, and availability of the Full Service Plan are subject to change at any time without notice. U.S. only. See terms and conditions at [www.qbes.com/terms](http://www.qbes.com/terms).
Learning Enterprise Solutions

Read this chapter to learn QuickBooks Enterprise Solutions basics, including how to get around and how to get answers to your questions:

- **Getting Around Enterprise Solutions on page 8** describes the Home page and shows you how to find your data.
- **Getting Answers to Your Questions on page 14** describes the variety of tools and resources that help you find answers to questions about QuickBooks Enterprise Solutions.
- **Enterprise Solutions Basics on page 20** explains important concepts you need to understand to use QuickBooks Enterprise Solutions effectively.
Getting Around Enterprise Solutions

The Enterprise Solutions work area is designed to enable you to complete tasks quickly. Enterprise Solutions provides several ways for you to work; choose the method that works best for you.

Using the Home Page

When you open a company file, the Home page displays automatically. Figure 1 shows the Home page.

The menu bar provides access to all tasks, features, and reporting functions.

The icon bar provides one-click access to QuickBooks centers and the Home page.

The Home page provides a quick glance around the state of your business.

The QuickBooks Coach walks you through business flows, and uses spotlights and tips to explain each step.

The In-product Help provides detailed instructions on how to perform tasks.
The Home page provides a big picture of how all your essential business tasks fit together. Tasks are organized into logical categories (Customers, Vendors, Employees, Company, and Banking) with workflow arrows to help you learn how tasks relate to each other and to help you decide what to do next.

**Note**

The workflow arrows indicate a logical progression of business tasks. However, these arrows do not restrict you from doing tasks in a different order, or an order that works better for your business needs.

To start a task, click the icon for the task you want to do. For example, to create an invoice, click the **Invoices** icon.

To return to the Home page, click the **Home** button in the icon bar.

The Home page also provides a quick glance around the state of your business. In the **Account Balances** list, you can see your current account balances, which are updated automatically as you do work.

The Home page is customized to display only those tasks and features you use, based on the questions you answer in the EasyStep interview. Functions you do not need do not clutter your workspace. However, if you decide to use these functions later, you can always add them back to the Home page. Go to the **Edit** menu and click **Preferences**. Click the **Desktop View** option and then click the **Company Preferences** tab.

If you are a new business owner or new to QuickBooks Enterprise Solutions, the QuickBooks Coach walks you through the business flows you see on your Home page. The QuickBooks Coach uses spotlights and tips to explain each step in your workflow.
Finding Your Data in the QuickBooks Centers

Enterprise Solutions includes Centers where you can view and manage all of your customer, vendor, and employee information and transactions. You can go to one of the centers by clicking the appropriate button in the icon bar (on the left side of the toolbar).

Customer Center

The Customer Center is a lens into all your customer information. Without having to sift through multiple screens, you can view a list of all your customers and see pertinent information for each of them. Click on a customer’s name and you immediately see all the activity you have had with them as well as their contact information (phone number, fax number, and payment terms).

You can use the Customer Center to find out how much money a specific customer owes you or to view a list of all your customers with open balances. You can also look at your customer transactions (estimates, sales orders, invoices, credit memos, refunds, and so on) across all of your customers in the transactions list rather than having to run separate reports.
Vendor Center

The Vendor Center gives you a complete picture about where your money is going. From one screen, you can see all your vendors and exactly what you owe them. Click on a vendor’s name to view an entire history with that vendor. You no longer need to run separate reports to see exactly how much business you are doing with each individual vendor. Also, you can sort your bills by due date so that you can stay on top of your finances.

If you need to talk to a vendor, click on the vendor name to see all the contact information. If a vendor calls you to follow up on a late payment, you can look up the bill quickly and see the check number and when you paid it.

Employee Center

The Employee Center lets you see exactly what you are paying each employee. Click on an employee’s name to view that person’s payroll history. If you need to get in touch with an employee, their contact information is right in front of you.

Payroll Center

If you subscribe to one of QuickBooks payroll services (additional fees apply), the Employee Center includes a Payroll Center. Use the Payroll Center to manage your payroll and payroll compliance.

*Note* Add-on services require subscription, EIN, or Internet access for certain features, including tax table updates and direct deposit.

The Payroll Center is a hub for managing all payroll activities. The Payroll Center reminds you of important payroll dates so you pay employees, pay your payroll liabilities, and file forms on time.

To visit the Payroll Center, click the Employee Center button on the icon bar and click the Payroll tab.
Getting a Real-Time View of Your Business

Use Company Snapshot to get a real-time view of your business on one page. You can see a trend graph of your income and expenses, your account balances, customers who owe you money, and vendors you need to pay. To open the Company Snapshot, go to the Company menu and click Company Snapshot.

Displaying Multiple Windows

Enterprise Solutions is preset to show multiple windows at the same time. By doing so, you can easily navigate between tasks as well as compare data in multiple windows. When you open a window, it opens to a preset size and location. You can resize and move each window as you see fit.

Depending on how you size or arrange the windows, some windows may not be visible. Use the Window menu to view a list of the open windows. Click the window name in the list to bring it to the front.

Alternatively, you can display the Open Window List to have the list of open windows always visible on the left side of the application window. Go to the View menu and click Open Window List. If you prefer to view only one window at a time, go to the View menu and click One Window.

Tip

If your work area becomes too cluttered with windows that you have open, you can close them all at once instead of closing them one at a time. To close all windows, go to the Window menu and click Close All.

When you close your company file at the end of the day, it is good practice to close all windows that you have open. The next time you open your company file, all the windows you had open when you closed your company file will re-open. If you forget to close open windows when you exit Enterprise Solutions, hold down the Alt key while opening your company file. Your company file displays with no windows open in your work area.
Adding Icons to the Icon Bar

For quick access to the areas of Enterprise Solutions you use most, you can customize the icon bar by adding many of the features and reports that you use most frequently.

![View Menu Screenshot]

**Figure 2 Adding Icons to the Icon Bar**

To add a shortcut for a window, such as **Enter Bills**, open that form and then display the **View** menu. The window you open appears as an option on the **View** menu.

**Note** Some windows cannot be added to the icon bar.

You can add, re-arrange, and remove shortcuts from the icon bar to suit your needs. To modify the icon bar, go to the **View** menu and click **Customize Icon Bar**.
Getting Answers to Your Questions

Enterprise Solutions provides a variety of tools and resources to help you find answers to questions you might have.


- Learn how to do common tasks by watching interactive, in-product tutorials. Refer to Using the Learning Center on page 18.

- Connect with other users and experts in the Live Community. Refer to Using the Live Community on page 19.

- Visit www.qbes.com/localhelp to find a local Intuit Solution Provider for on-site assistance. You can save time and money by using professionals to help you set up Enterprise Solutions, migrate your existing data into Enterprise Solutions, integrate Enterprise Solutions with your other software systems, and set up reports so you can better understand the health of your business.

- Visit www.qbes.com to contact the Intuit support team.

1. Internet access required for online services.
Using In-Product Help

In-product Help provides background information and instructions for doing Enterprise Solutions tasks. You can access the help content and features in several ways.

To use in-product Help, go to the Help menu and click QuickBooks Help or click the Live community button in the icon bar and then click the Help tab.

Viewing Help for a Window You Have Open

If you are unsure how to use a particular window, press the F1 key on your keyboard to get help. (You can also click the Help button in the window, if one is present.) These help topics provide answers to questions such as:

- What can I use this form for?
- What does this button do?
- What kind of information is displayed in this column?
- What happens when I select this option?
- How do I complete a task?
Information in the Relevant Topics Tab

Each time you open a new QuickBooks window, the links in the Relevant Topics tab change so that they apply to the active window.

Relevant Help topics explain how to use the window, and can include:

- Tutorials that show you how to complete tasks
- Business process overviews
- Step-by-step instructions
- Planning and best practice suggestions
- Troubleshooting information

If you do not see the information you need in the Relevant Topics tab, use the Search tab to find the topic.
Using Help Search

The in-product Help is quite extensive. If you do not see the information you are looking for in the Relevant Topics list, use the Search to find answers to your questions quickly:

1. Click the Search tab.

2. In the Search field, type a short phrase (containing a noun and verb) that describes the information you want. For example, add a customer or How do I add a customer?

3. Click the search arrow. Search returns a maximum of 15 topics based on the words you enter.

Figure 3 shows the Search tab

```
4 have a question?  help
live community  relevant topics  search

add customer

15 topics found:
? Add a customer
? Add customer messages, disclaimers
? Add custom item fields
? Add custom name fields
? Using the Customers & Jobs list
? Add a note about a customer or job
```

Tips

- Be as specific as possible. For example, if you want to know how to add a customer, entering just customer returns topics ranging from adding a customer to deleting a customer and more. Instead, enter add customer or how do I add a new customer?

- Enter a shorter search phrase or question. For example, how do I add customers returns better results than How do I add new customers and vendors.
Try using different words and phrases. For example, if you are looking for something about installing an Enterprise Solutions update, enter update Enterprise Solutions.

Do not use abbreviations. Use the full word instead.

**Using the Learning Center**

As you begin using Enterprise Solutions, one of the first things you see is the Learning Center. The Learning Center provides interactive tutorials to help you learn how to use Enterprise Solutions. After you complete a tutorial, a checkmark displays next to its title.

To open the Learning Center, go to the Help menu and click **Learning Center Tutorials**. You can also access the tutorials from the QuickBooks Coach.

**Using the QuickBooks Coach**

If you are new to Enterprise Solutions, you can explore the Home page with the QuickBooks Coach to learn more about your business workflows. Click **Start Working** to turn on explore mode. Then mouse over and click the Coach icons to see:

- Details about your workflows
- Spotlights that show you the steps in a flow, with tips to complete each step
- Bold numbers, highlighted lines, and arrows show you the order in which to do your work
Using the Live Community

The Live Community enables you to ask other users and experts for help and get answers fast, right inside Enterprise Solutions. Use Live Community to ask any question, from how-to questions about Enterprise Solutions to advice on how to run and grow your business. To use Live Community, go to the Help menu and click Live Community.

Type your question here and click Ask My Question. Enterprise Solutions notifies you when someone answers your question.

Previously asked questions that someone has answered display here.

Questions that have yet to receive answers from the community display here. Click a link to post an answer.
Enterprise Solutions Basics

To take full advantage of Enterprise Solutions, there are some important concepts you need to understand.

Working with Lists

You use information stored in lists to fill out most QuickBooks forms. For example, to create an invoice, you choose the customer name from your Customer & Job list. Enterprise Solutions automatically enters the customer information on the form for you. This saves you time and prevents typing errors. You can also change the information directly on the form as needed. Lists are easy to set up, but do require careful planning.

Depending on the type of list you want to use, you can get the list in one of two ways:

- **QuickBooks Centers**

  Your Customers & Jobs, Vendors, and Employees lists are available in the Customer, Vendor, and Employee Center. Click the appropriate QuickBooks Center button on the icon bar to go to a QuickBooks Center. Then, click the tab for your list.

- **List Windows**

  Other lists, such as the Chart of Accounts and Item List, appear in separate windows. To view one of these lists, click the Lists menu and then click the list you want. To enter information in these fields, use the menu button at the bottom of the list to add, edit, or delete list items. The Lists menu also provides access to features associated with the list.

The more detail you enter for each list item, the more information Enterprise Solutions can use to pre-populate forms, track financial data, and display useful reports about your business. Another advantage of lists is that common tasks like adding list entries, editing list information, and deleting list entries are performed the same way.
**Entering List Information as You Work**

There are two basic methods you can use to enter list information. You can enter account, customer, vendor, product and service information before you enter transactions, or you can enter this information as you use the product.

If you prefer to enter information as you use the product to perform your daily tasks, Enterprise Solutions prompts you to immediately set up any entry it does not know about. You can always add more information to the record at a later time from the appropriate list.

**Writing Checks Versus Paying Bills**

You can manage and pay your bills in two ways:

- **Write checks to pay bills now.**

  Use the **Write Checks** window and assign the amounts to appropriate expense accounts. Intuit recommends this method when you do not receive a bill; for example, when you go to the store and write a check and then you need to record that expense in Enterprise Solutions. You can also use **Write Checks** to pay a bill as soon as you receive it, as long as you do not need to track the bill.

  **Note:** Use the method above if you are using accrual-based accounting methods.

- **Enter bills when you receive them and pay them later.**

  Use the **Enter Bills** window to enter bills when you receive them. Then use the **Pay Bills** window to pay bills when they are due. You can set up Enterprise Solutions to remind you to pay bills when they are due. Using this method, you keep your money in your business for as long as possible. You might still use a check to pay the bill, but this method enables you to track how much money you owe. And at any time, you can run reports to analyze unpaid bills for information such as to which vendors you owe money.

  **Note:** Do not simply write a check in the **Write Checks** window to pay bills that you entered in the accounts payable register or the **Enter Bills** window. Use the **Pay Bills** window to pay these bills.
What Happens When You Record a Bill Payment?

If you paid by:

- **Check** — Enterprise Solutions prepares one check for each vendor and records the checks in the check register with BILLPMT in the Type field.

- **Credit card** — Enterprise Solutions records a charge for each vendor in your credit card register.

- **Cash** — Enterprise Solutions records a payment for each vendor in your cash account register.

- **Online banking payment** — Enterprise Solutions prepares one online banking payment instruction for each vendor and records the payments in the check register with BILLPMT in the Type field.

In each scenario, Enterprise Solutions records the payment to each vendor in the accounts payable register. The amount you paid appears in the Payment column.

Using Multiple Currencies

Enterprise Solutions supports all global currencies so you can work with international vendors and customers. You can assign a currency to customers, vendors, price levels, bank accounts, credit card accounts, and accounts receivable/accounts payable accounts. Other account types, like income and expense accounts, always use your home currency.

**Important**

Multiple currency affects many accounts and balances in your company file and is irreversible. Intuit recommends that you back up your company file before turning on Multiple Currencies.

- **To turn on Multiple Currencies:**
  1. Go to the Edit menu and click Preferences.
  2. In the Preferences list, click Multiple Currencies.
  3. Click the Company Preferences tab.
  4. Click Yes, I use two or more currencies.
5 Select your home currency from the drop-down list.

Your home currency is the currency of the country where your business is physically located. In most cases, the home currency is the US dollar (USD).

*Important* If you choose to set a home currency other than the US dollar, Intuit services such as payroll and online banking will not be available; these services are only available in US dollars.

For more information about Multiple Currencies, refer to the In-product Help.

**Using the Sample Company Files**

Enterprise Solutions includes several sample company files with which you can practice to enter pretend data, run reports, and explore features. To open a sample company file, go to the File menu, click **Open or Restore Company**, and then click a sample company file from the list.
Setting Up Your Business

Read this chapter to learn essential tasks for setting up your business:

- Customizing Enterprise Solutions on page 26 describes how to customize the way you work.
- Adding an Account on page 28 describes how to add accounts.
- Adding Customers on page 33 describes how to add customers.
- Adding Vendors on page 35 describes how to add vendors.
- Adding Items on page 36 describes how to add items.
- Setting Up Sales Tax on page 40 describes how to set up sales tax.
- Setting Up Payroll on page 49 describes how to set up Payroll.
- Setting Up Employees on page 52 describes how to set up employees.
Customizing Enterprise Solutions

Preferences customize Enterprise Solutions to suit the needs of your business and your personal style of working. From the Preferences window, you can define preferences in over a dozen different categories.

For example, you can configure general preferences such as whether or not Enterprise Solutions prompts you before editing or deleting a transaction, or which date it uses for new transactions. Or, you can configure accounting-specific preferences such as how to display accounts and subaccounts. Figure 4 shows the Preference options.

Figure 4  Modifying Preferences

Use Company Preferences to set global preferences that affect all users of the company file. Only the QuickBooks Administrator can set up or modify company preferences.

Use My Preferences to set personal QuickBooks preferences, such as using the Enter key instead of the Tab key to move between fields.
To view and set preference options:

1. Go to the Edit menu and click Preferences.

2. In the Preferences window, change any of the general preferences. These preferences determine how Enterprise Solutions behaves.

3. To display the preferences for specific categories, click the appropriate category in the list on the left. For example, to set preferences for reporting functions, click Reports and Graphs.

4. On the My Preferences tab for the particular feature area, enter the changes and settings you want. These settings affect only your Enterprise Solutions sessions, not those of other users.

5. Do one of the following:
   - Click OK to close the Preferences window and save your changes.
   - Click another feature area in the scroll box to enter other preferences. Click Yes when prompted to save your changes.

6. Click OK.
Adding an Account

When you set up your company file, Enterprise Solutions sets up certain accounts for you automatically. However, as your business grows or changes, you might need to add new accounts to your chart of accounts to better organize your finances. Or, you might need an account that was not provided during setup. For example, you might want to create expense accounts to track office supply purchases separately from advertising costs.

Note
To set up your accounts correctly, you might need to get help from an accounting professional.

To add an account:

1. Go to the Lists menu and click Chart of Accounts.
2. Click the Account button and then click New.
3. In the Add New Account: Choose Account Type window, select the type of account you want to create and then click Continue.
   Refer to Table 1 on page 30 for a description of the different types of income, expense, and balance sheet accounts.
4. Enter the account’s name in the Account Name field. This name appears on all your company financial statements.
5. If you want to make this account a subaccount of another account, click the Subaccount of checkbox. From the drop-down list, click the account that will be the higher-level account for this subaccount.
6. (Optional) Enter a short description, note, bank account number, or credit card number, depending on the type of account you are adding.
7. For income and expense accounts. From the Tax Line Mapping drop-down list, click the appropriate tax line or <Not tax-related>.
8. For balance sheet accounts. Enter an opening balance based on the account’s balance as of your QuickBooks start date. Generally, you should enter any balance sheet balances as of the day before your start date. That way it is all exactly correct at the opening of your start date. If you are putting money into the account with a...
transaction, do not use the opening balance field, as this will create an additional transaction. If you are not sure of the balance, you can leave the field blank and enter the information later. Click OK when finished.

9 Click Save & Close or Save & New to add another account.

**Note** You can also add accounts as you perform everyday tasks. For example, if you are writing a check and enter an account name that has not yet been set up in Enterprise Solutions, you will be prompted to set up the new account. If you need to make changes to your account information, double-click the account in the Chart of Accounts list. The Edit Account window opens; make your changes and click OK.

### Using Subaccounts

When you need more detail about what is going on in an account, you can divide the account into one or more subaccounts, which let you track several related types of income or expenses independently yet keep them all under the umbrella of a single parent account. Subaccounts appear indented immediately below their parent account in your chart of accounts. If you create subaccounts, it is best not to post anything to the parent account. For example, if your business has substantial advertising expenses, you might decide to divide your Advertising expense account into several subaccounts, such as Newspaper Ads, Signs, Yellow Pages, and Direct Mailings.

### Creating Brand New Accounts

When you create a brand new account, leave the opening balance at zero. The opening balance will be created automatically when you transfer funds from another account.

**Account Types**

There are two main types of accounts in the chart of accounts:

- Income and expense accounts
- Balance sheet accounts
Income and Expense Accounts

Income and expense accounts track the sources of your income and the purpose of each expense. When you record transactions in one of your balance sheet accounts, you usually assign the amount of the transaction to one or more income or expense accounts. For example, not only do you record that you took money out of your checking account, but you keep track of what you spent the money on (utilities or office supplies). Table 1 lists income and expense accounts and describes when to use them.

<table>
<thead>
<tr>
<th>Account Type</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>Income</td>
<td>Categorizes money earned from normal business operations, such as product sales, service sales, and discounts to customers.</td>
</tr>
<tr>
<td>Other Income</td>
<td>Categorizes money your business earns that is unrelated to normal business operations, such as dividend income, interest income, and insurance reimbursements.</td>
</tr>
<tr>
<td>Expense</td>
<td>Categorizes money spent in the course of normal business operations, such as advertising and promotion, office supplies, insurance, legal fees, charitable contributions, and rent.</td>
</tr>
<tr>
<td>Other Expense</td>
<td>Categorizes money your business spends that is unrelated to normal business operations, such as corporation taxes and penalties and legal settlements.</td>
</tr>
<tr>
<td>Cost of Goods Sold</td>
<td>Tracks the direct costs to produce the items that your business sells, such as cost of materials, cost of labor, subcontractors, and shipping.</td>
</tr>
</tbody>
</table>

Table 1  Income and Expense Account Types

Enterprise Solutions does not display balances for income and expense accounts in the chart of accounts. To see these balances, go to the Reports menu, click Report Center, and then click the Company & Financial category. You can also double-click the income or expense account in the chart of accounts to display a QuickReport.

The chart of accounts is a complete list of your business accounts and their balances. You use a chart of accounts to track how much money your
company has, how much money it owes, how much money is coming in, and how much is going out.

*Important* The IRS recommends opening a business checking account as one of the first things you do when starting a new business. Intuit highly recommends associating your income and expense accounts with the appropriate tax lines for your tax forms. Consult with your accountant if you need more information about which tax forms to use and to which tax lines to map each account.

### Balance Sheet Accounts

Enterprise Solutions provides several types of balance sheet accounts to choose from as you create and add to your chart of accounts. Use the type of account that best describes the type of data you are tracking.

*Table 2* lists the balance sheet accounts and when to use them.

<table>
<thead>
<tr>
<th>Account Type</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bank</strong></td>
<td>Tracks money you have in your cash accounts. Create one for each cash account, such as petty cash, checking, savings, and money market. <strong>Tip:</strong> When you create a new bank account, leave the opening balance at zero. The opening balance is created automatically when you transfer funds from another account.</td>
</tr>
<tr>
<td><strong>Accounts Receivable (A/R)</strong></td>
<td>Tracks money your customers owe you on unpaid invoices. Most businesses require only the A/R account that Enterprise Solutions automatically creates after you create your first invoice.</td>
</tr>
<tr>
<td><strong>Other Current Asset</strong></td>
<td>Tracks the value of things that you can convert to cash or use up within one year, such as prepaid expenses, employee cash advances, inventory, and loans from your business.</td>
</tr>
<tr>
<td>Account Type</td>
<td>Purpose</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Fixed Asset</td>
<td>Tracks the value of significant items (consult your tax professional for a minimum dollar amount) that have a useful life of more than one year, such as buildings, land, machinery and equipment, and vehicles.</td>
</tr>
<tr>
<td>Other Asset</td>
<td>Tracks the value of things that are neither Fixed Assets nor Other Current Assets, such as Goodwill, long-term notes receivable, and security deposits paid.</td>
</tr>
<tr>
<td>Accounts Payable (AP)</td>
<td>Tracks money you owe to vendors for purchases made on credit. Most businesses require only the A/P account that Enterprise Solutions automatically creates after you create your first invoice.</td>
</tr>
<tr>
<td>Credit Card</td>
<td>Tracks credit card purchases, bills, and payments. Create one for each credit card your business uses.</td>
</tr>
<tr>
<td>Other Current Liability</td>
<td>Tracks money your business owes and expects to pay within one year, such as sales tax, security deposits/retainers from customers, and payroll taxes.</td>
</tr>
<tr>
<td>Long-Term Liability</td>
<td>Tracks money your business owes and expects to pay back over more than one year, such as mortgages, long-term loans, and notes payable.</td>
</tr>
<tr>
<td>Equity</td>
<td>Tracks money invested in, or money taken out of, the business by owners or shareholders. Payroll and reimbursable expenses should not be included.</td>
</tr>
</tbody>
</table>

Table 2  Balance Sheet Account Types
Adding Customers

Customers (also called clients or members) are the lifeline of your business. By entering detailed information in Enterprise Solutions about the people and companies to whom you sell your products and services, you can personalize their bills, send invoices easily, and quickly view the status of their accounts. You can add new customers at any time.

Tip Typing in customer data for hundreds of customers can be a tedious task. If you use Microsoft Outlook, you can import your existing customer information into Enterprise Solutions instead of entering it manually. Refer to the in-product Help for instructions on how to prepare your customer data file for importing into Enterprise Solutions.

◊ To add a customer:

1. Click the Customer Center icon at the top of the QuickBooks Enterprise Solutions window.
2. Click New Customer & Job and then click New Customer.
3. On the Address Info tab, enter all the data that you have about the customer, including their name, Bill To and Ship To addresses, and additional contact information.
4. Complete the Additional Info and Payment Info tabs, as appropriate. If you want to add additional fields to the form, click Define Fields to customize the form.
5. Click OK or Next (if you want to enter another customer).
You can also add customers as you perform your everyday tasks. For example, if you enter the name of a new customer when filling out an invoice, Enterprise Solutions prompts you to enter information about this customer. You can choose from two quick setup options:

- **Quick Add** adds just the name to the list. You must add the details later.

- **Set Up** enables you to enter additional information (such as phone number, fax number, and alternate contact) to the list you choose.

If you are performing more than one job for a customer, you can track the jobs individually by adding new jobs under the customer’s name in the **Customers & Jobs** list. That way, you can create reports that show the income and expenses for each job. To add a job, click **New Customer & Job** and then click **Add Job**.

If you need to add several customers to your company file, consider using the **Add/Edit Multiple List Entries** feature to quickly enter multiple customers at one time. For more information, see QuickBooks Help and search for “Add and edit multiple customers.”
Adding Vendors

The vendor list holds information about the people and companies you buy goods and services from to run your business; for example, this list could include the phone company, your office supplies vendor, and your tax board. You can add new vendors at any time.

Typing in vendor data for hundreds of vendors can be a tedious task. If you use Microsoft Outlook, you can import your existing vendor information into Enterprise Solutions instead of entering it manually. Refer to the in-product Help for instructions.

To add a vendor:

1. Click the Vendor Center icon at the top of the QuickBooks Enterprise Solutions window.
2. Click New Vendor.
3. On the Address Info tab, enter all the data that you have about the vendor, including their name, address, and additional contact information.
4. If you owe this vendor money as of your company’s start date, enter the amount in the Opening Balance field.
5. Click the Additional Info tab and complete the form, as appropriate. If you want to add additional fields to the form, click Define Fields to customize the form.
6. Click OK or Next (if you want to enter another vendor).

You can also add vendors as you perform your everyday tasks. For example, if you enter the name of a new vendor when paying a bill, Enterprise Solutions prompts you to enter information about this vendor. You can choose from two quick setup options:

- **Quick Add** adds just the name to the list. You must add the details later.
- **Set Up** enables you to enter additional information (such as phone number, fax number, and alternate contact) to the list you choose.
If you need to add several vendors to your company file, consider using the Import/Export functions to enter multiple vendors at one time. See the in-product Help for instructions on how to import lists.

## Adding Items

An item is anything that might appear as a line item on an invoice, including subtotals, discounts, and sales tax, as well as the products and/or services that you sell. You enter items on your invoices and sales receipts. For example, a writing consultant might set up one item for editing services with an hourly rate, and another item for writing services with a different hourly rate. On an invoice, the items would be entered with the number of hours worked as the quantity.

While providing a quick means of data entry, items also handle the behind-the-scenes accounting. When you create an item you link it to an account. When the item is used on a form it posts an entry to that account and another to the appropriate accounts receivable, accounts payable, checking, or other account.

When you choose an item from the Item list, Enterprise Solutions fills in a description of the line item and calculates its amount for you.

Enterprise Solutions provides several different types of items, described in Table 3, below. Some items, such as service or inventory part items, help you record the services and products your business sells. Other items, such as the subtotal or discount item, are used to perform calculations on the amounts in a sale.

<table>
<thead>
<tr>
<th>Item Type</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Service</strong></td>
<td>Use for services you either charge for or purchase, like specialized labor, consulting hours, and professional fees.</td>
</tr>
<tr>
<td><strong>Inventory Part</strong></td>
<td>Use for goods you purchase, track as inventory, and resell.</td>
</tr>
<tr>
<td><strong>Inventory Assembly</strong></td>
<td>Use for assembled goods you build or purchase, track as inventory, and resell.</td>
</tr>
<tr>
<td>Item Type</td>
<td>Purpose</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Non-Inventory Part</td>
<td>Use for goods you buy but do not track, like office supplies, or materials you buy for a specific job that you charge back to your customer.</td>
</tr>
<tr>
<td>Other Charge</td>
<td>Use for miscellaneous labor, material, or part charges, such as delivery charges, setup fees, and service charges.</td>
</tr>
<tr>
<td>Subtotal</td>
<td>Use to total all items above it on a form, up to the last subtotal. Useful for applying a percentage discount or surcharge to several items</td>
</tr>
<tr>
<td>Group</td>
<td>Use to quickly enter a group of individual items on an invoice.</td>
</tr>
<tr>
<td>Discount</td>
<td>Use to subtract a percentage or fixed amount from a total or subtotal. Do not use this item type for an early payment discount; for an early payment discount, use the Set Discount feature in the <strong>Receive Payments</strong> window.</td>
</tr>
<tr>
<td>Payment</td>
<td>Use to record a partial payment you received at the time of the sale. It reduces the amount owed on an invoice.</td>
</tr>
<tr>
<td>Sales Tax Item</td>
<td>Use to calculate a single sales tax at a specific rate that you pay to a single tax agency.</td>
</tr>
<tr>
<td>Sales Tax Group</td>
<td>Use to calculate and individually track two or more sales tax items that apply to the same sale. The customer sees only the total sales tax.</td>
</tr>
</tbody>
</table>

Table 3  Item Types
To add an item:

1. Go to the Lists menu and click Item List.
2. Click Item at the bottom of the list and then click New.
3. Click the Type drop-down arrow and choose the type of item you want to create.
4. Enter an item name as you want it to appear on purchase and sales forms.
5. Enter the description that you want to appear on sales forms when you use the payment item.
6. In the Rate field, enter the amount you want to charge for the item or leave as zero, if the rate varies.
7. In the Account field, choose the account that is associated with this item. (In most cases, you will assign the item to an income account.)
8. In the Tax Code list, select the appropriate sales tax code or create a new one. If you do not see the Tax Code list, you must turn on the tax preference in the Sales Tax area under Edit/Preferences.
9. Click OK or Next (if you want to enter another item).
Why are Item Types Important?

Although you can use items as a quick means of entering data, items fulfill a much more important role into handling the behind-the-scenes accounting.

When you create an item, you link it to an account; when the item is used on a form, it posts an entry to that account and another entry to the appropriate accounts receivable, accounts payable, checking, fixed asset, or other account.

While items are easy to set up, you should spend some time deciding how they can best work for you before you start setting them up and using them. Use your current list of services and products as a starting point. Consider how much detail you want on your invoices or statements and set up your items with that level of detail in mind. For example, if you are a seamstress who creates and sells home accessories, you can set up a single item and charge a flat rate for a certain size of couch pillow, or you can break that pillow down further into labor and materials.

Furthermore, Enterprise Solutions provides many useful reports that break information down by the goods or services you purchase and sell. That way, you can quickly find out:

- How much income your items bring in
- What you are spending to purchase items
- How well you estimate the cost of items
- How much time you spent on each type of job or item
Setting Up Sales Tax

Depending on where you do business, you might be required to collect sales tax for the products or services you sell. If you collect sales tax, you must pay it to a tax agency on a regular schedule. Enterprise Solutions helps automate your sales tax tracking so you can keep accurate records about the sales tax you collect and pay.

Important
You must follow the rules and regulations for collecting and paying sales tax in your tax district (city, county, state).

Understanding How Sales Tax Works

Enterprise Solutions uses sales tax codes to track the taxable or non-taxable status of both the items you sell (products and services) and your customers. If your tax agency requires you to report the reasons why particular sales are taxable or non-taxable, the sales tax codes that you assign to your items and customers enable you to run reports that provide this information for your sales tax return.

Enterprise Solutions uses sales tax items to calculate and add sales tax charges when you make a taxable sale. When you set up a sales tax item, you assign a sales tax rate to it and associate it with the tax agency to which you pay the sales tax. All of the sales tax items you set up are in your Item list. Once you have set up sales tax, Enterprise Solutions automatically applies the appropriate sales tax rate to the sale of your taxable items.
Before You Start Setting Up Sales Tax

To set up sales tax in Enterprise Solutions, you need to know the following sales tax requirements for the locations where you sell your products and services:

- **Sales tax rates** for each tax district (a city, county, or state that has a sales tax) in which you sell. You may have multiple sales tax rates that you need to charge, for example, sales tax for both a county and a state.
- **Tax agencies** to which you pay the collected sales tax for each of those district taxes.

You can find your sales tax requirements (rates, payment schedules, and so on) online at your state sales tax website. Intuit has provided access to these websites from the in-product Help. Go to the Help menu and click QuickBooks Help. In the Search box, type Finding the sales tax rates and requirements for your business and press Enter. Click the topic to open it and then click the link for your state.

<table>
<thead>
<tr>
<th>Term</th>
<th>How it relates to sales tax setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales Tax Rate</td>
<td>The percentage charged for sales tax by the tax district. For each different district/rate combination, you need to set up a new sales tax item. For example, you might sell in three counties that all charge the same sales tax rate, but you need a separate sales tax item for each county, even though the sales tax rate is the same. This enables you to track the amounts of sales tax you collect for each tax district.</td>
</tr>
<tr>
<td>Sales Tax Item</td>
<td>An item that is used to calculate the appropriate sales tax for a sale. A sales tax item includes a sales tax rate and a tax agency. When you sell taxable items, you charge the appropriate sales tax rate by assigning a sales tax item to each sale.</td>
</tr>
<tr>
<td>Term</td>
<td>How it relates to sales tax setup</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Sales Tax Group Item</td>
<td>An item that groups multiple sales tax items so you can charge only one rate on your sales. For example, the location where you sell might require you to charge both a county and a state sales tax. However, customers are used to seeing one sales tax rate on sales. You would set up a sales tax group item that combines those two sales tax rates, for example 1% for the county and 7% for the state, to create a single, sales tax group item with a rate of 8%. You would apply this sales tax group item to your taxable sales for that county.</td>
</tr>
<tr>
<td>Sales Tax Code</td>
<td>The identifier that Enterprise Solutions uses to track the taxable and non-taxable status of both the products and services you sell, and the customers to whom you sell these items. For example, a customer that is a non-profit organization might have a non-taxable status. You would not charge sales tax for anything you sell to this particular customer.</td>
</tr>
<tr>
<td>Tax District</td>
<td>A town, city, county, or state that charges sales tax. A tax district might also include a municipal or special jurisdiction, such as a Mass Transit tax or a parish in Louisiana.</td>
</tr>
<tr>
<td>Tax Agency</td>
<td>The government office that determines the requirements for sales tax collection or payment. You might need to pay your collected sales tax to one or more tax agencies, depending on the requirements for the locations (tax districts) where you do business. Tax agencies are set up as vendors because you make payments to them. A tax agency is sometimes called a tax authority.</td>
</tr>
</tbody>
</table>

Table 4  Sales Tax Terms
Setting Sales Tax Preferences

Figure 5 shows the sales tax preferences.

![Setting Sales Tax Preferences](image)

**Figure 5  Setting Sales Tax Preferences**

### Setting Up Sales Tax

Setting up sales tax is a multi-step process, divided into three main parts:

- **Part 1**: Sales tax payment schedule
- **Part 2**: Sales tax codes to track taxable status of items and customers
- **Part 3**: Sales tax items, rates, and tax agencies
Part 1: Sales Tax Payment Schedule

In this procedure, you turn on sales tax and then set up information about when you need to pay your tax agency.

♦ To set up your sales tax payment schedule:

1 Go to the Edit menu and click Preferences.
2 Click Sales Tax in the list on the left.
3 Click the Company Preferences tab.
4 For the question Do You Charge Sales Tax? click Yes.
5 Select when you owe sales tax to the tax agency, as specified by your tax agency:
   - Select As of invoice date if your tax agency stipulates that you owe sales tax from the moment you write an invoice or make a sale.
   - Select Upon receipt of payment if your tax agency stipulates that you owe sales tax when you receive the payment from a customer.

Note: This preference overrides the accounting basis you have set for your company and for your report preferences (for example, if your report preference is set to cash but you select accrual here, your sales tax reports will be accrual-based).

6 Select how often you pay sales tax to the tax agency, as specified by your tax agency. If you do not know which time period to choose, check your sales tax license. It should indicate the payment schedule that you need to use.

Tip If you collect sales tax for multiple tax agencies that require payment at different intervals, use the payment interval you use most frequently. When you run your sales tax reports and make your payments, you will be able to see which amounts are due on which dates.

Note The time interval you select to pay your sales tax is reflected in the period of time covered by your sales tax reports and sets reminders to pay your sales taxes. For example, if you select Monthly, Enterprise Solutions uses the previous month as the basis for your sales tax reports. When it is time to pay your sales tax using the Pay Sales Tax feature, Enterprise Solutions reminds you to make the payment.
QuickBooks Enterprise Solutions includes a Manage Sales Tax window to help you complete all of your common sales tax tasks, like setting sales tax preferences, preparing state sales tax forms, and paying sales tax. Go to the Vendors menu, click Sales Tax, and then click Manage Sales Tax to open this window.

**Part 2: Setting Up Sales Tax Codes**

Now you will set up the sales tax codes that you will use to track the taxable and non-taxable sales status of your items and customers. Later, you will assign these sales tax codes to your customers and the items you sell.

Enterprise Solutions creates two sales tax codes for you:

- The taxable code (TAX) is assigned to items and customers that are taxed.
- The non-taxable code (NON) is assigned to items and customers that are not taxed, such as non-profit organizations or items that the customer plans to resell.

Depending on your tax agency requirements, these two preset sales tax codes might be all you need to use. In which case, you do not need to set up any additional codes or change this preference.

If your tax agency requires you to specify additional sales tax codes to track taxable and non-taxable sales, such as specific tracking for out-of-state sales, you can set them up now. (You can also set them up later when you need to use them.)

◊ **To set up additional sales tax codes:**

1. Click the drop-down list for the type of sales tax code you want to set up (Taxable or Non-taxable) and click Add New.

2. In the New Sales Tax Code window, enter a sales tax code you want to use and a description for it.

   Each sales tax code you add must be unique. For example, you might want to set up a non-taxable sales code for labor costs. You might enter LBR as the sales tax code and Labor, non-taxable as the description. Many businesses also use a non-taxable out-of-state sales tax code (OOS).
3 Click OK.

4 Repeat steps 1 through 3 for each sales tax code you want to add.

**Part 3: Sales Tax Items, Rates, and Tax Agencies**

You need to set up a sales tax item for each tax district (city, county, state) in which you sell. A sales tax item includes the sales tax rate you need to charge for that tax district and the tax agency to which you remit the sales tax you collect. Even if you sell in three different counties that all have the same sales tax rate, you need to set up a separate sales tax item for each county/rate combination so that you can properly track your sales tax collection and payments.

◆ **To set up your sales tax items, rates, and tax agencies:**

1 In the Most common sales tax field, click the drop-down arrow and then click *Add New*.

2 In the New Item window, click the Type drop-down arrow and then click *Sales Tax Item*.

3 Enter the sales tax name. (Use a name that describes the location for the Tax, such as San Mateo County. This name will appear as one of the choices in the Tax field on your sales forms.)

4 Enter a description for the way this sales tax item will appear as a line item on your sales forms (for example, San Mateo County sales tax). You cannot edit it on the forms themselves. Users frequently use the name of the sales tax item as the description.

5 Enter the sales tax rate (as a percentage) you charge when a sale is taxable. For example, your sales tax rate for San Mateo County might be 1.25% (1.25 cents per dollar purchased).

6 In the Tax Agency drop-down list, select *Add New* to open the New Vendor window, where you can set up the tax agency (a vendor) to which you pay this sales tax.

7 Enter a vendor name and contact information. For example, in California, sales tax is paid to the Board of Equalization.

8 Click OK to close the New Vendor window.
9 Click OK to close the New Item window.

10 Repeat steps 1 through 9 for each local, county, or state sales tax item and rate you need to set up.

*Important*

Depending on your sales tax requirements, you might need to combine multiple sales tax items to create a sales tax group item. For example, a county sales tax rate of 1.25% and a state sales tax rate of 7.0% would combine for a sales tax group item with a sales tax rate of 8.25%. Then, you can use this single sales tax rate on your sales forms.

11 When you have finished setting up all your sales tax items, choose your Most common sales tax, which is the one you charge most often. Remember, the most common sales tax that you charge your customers might be a sales tax group item.

12 In the Sales Tax preferences window, decide if you want to mark your taxable items when your sales forms are printed. If not, clear this checkbox.

13 Click OK to apply your sales tax preferences. If you have already set up your items and customers, you are prompted to assign a taxable sales tax code to all of them. Click OK if most of your items and customers are taxable. If not, clear the checkboxes and click OK.
Entering an Opening Balance for Sales Tax Liability

You need to enter an opening balance for your Sales Tax Liability account (what you owe as of your QuickBooks start date). After your start date, your sales tax is included on your sales forms and entered into this account.

Caution Do not use this procedure if you entered historical invoices or sales receipts dated before your QuickBooks start date. Your sales tax will already be included on them and posted to this account. You can also skip this procedure if you entered an opening balance for each tax agency as you set it up.

To enter your sales tax liability for a tax agency:

1. Go to the Lists menu and click Chart of Accounts.
2. Double-click the Sales Tax Payable account.
3. In the register, find a blank transaction and fill in the details for the tax agency owed:
   - In the Date field, enter your QuickBooks start date.
   - In the Vendor field, enter the tax agency.
   - In the Billed field, enter the amount you owed as of your start date.
   - From the Account drop-down list, choose Opening Bal Equity.
4. Click Record.
5. Repeat steps 3 and 4 for each tax agency to which you owed sales tax as of your QuickBooks start date.

Note In many states where you charge a state sales tax rate, you also need to charge for a city or county sales tax along with it. However, your customers are used to just seeing one sales tax item on their invoices or sales receipts. You can resolve this issue by creating sales tax group items. Once you have set up all of your sales tax items for your city, county, and state sales tax rates, you will be ready to combine the rates to create a sales tax group item.
Setting Up Payroll

As an employer, you have specific payroll responsibilities that are required by government agencies. These agencies can be federal, state or local. Some of these responsibilities include, but are not limited to, withholding amounts from your employees’ compensation to cover income tax, social security, Medicare, and other payments.

Choosing a Payroll Service

To manage your payroll, you first need to subscribe to a QuickBooks Payroll Service. QuickBooks flexible options ensure that you get the payroll service is right for you. Enterprise Solutions also includes payroll features that do not require a payroll service subscription. Refer to the in-product Help for more information about using payroll without a payroll service. Consult with a tax professional or accountant to address all your specific needs for your business.

You can learn about all of the payroll offerings, including manual payroll through the QuickBooks Payroll website.

♦ To learn about and sign up for a Payroll Service:

1. Go to the Employees menu and click Payroll.
2. Click Learn About Payroll Options.

If you are not sure which payroll service is right for you, contact one of our payroll experts at 866.820.6382 to learn more and help you choose.

If you choose to sign up for a payroll service, you are prompted to complete the activation process for your service. After you complete your activation, you can set up payroll for your business as described in the next section.
Preparing Payroll Information

Enterprise Solutions Payroll includes an easy-to-use Payroll Setup interview that guides you through setting up payroll for your business. Payroll Setup helps you set up your employees, set up compensation and benefit information, as well as enter any year-to-date payroll data. The Payroll Setup interview also guides you through setting up scheduled payments for your payroll tax and non-tax liabilities (such as health insurance and 401(K)). Scheduled payments help you manage your payroll more efficiently.

Before you begin setting up payroll, Intuit recommends you gather all of the information in the payroll setup checklist at http://www.payroll.com/support/PDFs/Misc/Payroll_Setup_Checllist.pdf. You can find this information in your own records, from your accountant or Enterprise Solutions Provider, or from federal and/or state agencies.

♦ To set up payroll for your business:

1. Go to the Employees menu and click Payroll Setup.
2. Follow the onscreen instructions.

   Tip: If at any time you need to leave the Payroll Setup interview before completing all of your payroll setup tasks, click the Finish Later button. When you reopen the Payroll Setup interview, you can continue. To ensure accurate payroll calculations, complete your setup before using the Payroll.

Payroll Setup has been grouped into the following categories:

- **Company Setup** — Enter information about the types of compensation and benefits you provide.

- **Employee Setup** — Enter employee personal information (name, hire data, Social Security Number, and so on), pay information (pay rate, payments and deductions, paid time off balances, and so on), and tax withholding information (from W-4 and state forms).

- **Taxes** — QuickBooks Payroll automatically sets up your state and federal taxes. However, you must still enter employer-specific tax rates (state unemployment insurance) as well as any local taxes that may apply.
Setting Up Payroll

- **Payroll History** — If you have issued paychecks during this calendar year prior to using QuickBooks Payroll, you must provide year-to-date payroll history to accurately generate tax payments and filings.

*Note* After your initial payroll setup, you may need to add new employees or edit employee payroll information. You do not need to use the Payroll Setup interview for these quick tasks. Instead, follow the instructions for adding and editing employee information listed on page 52.
Setting Up Employees

Employees are people who work for your company. Employees can work full time or part time. To process paychecks and prepare tax documents for your employees, you need to enter specific information about each of your employees. Refer to the payroll setup checklist at http://www.payroll.com/support/PDFs/Misc/Payroll_Setup_Checklist.pdf for a list of employee information to gather.

*Note* If you have employees who need a 1099 (for example, subcontractors), set them up as vendors, not employees.

Generally, people in business for themselves are not employees of the company. However, if your company is incorporated, working corporate officers are considered employees. Check with your accountant or payroll professional to determine if the owner should be considered an employee and then set up the owner accordingly.

*Note* If you are a QuickBooks Payroll subscriber, you will be prompted to add all of your employee information during payroll setup. Use the following procedure to edit employee information or to add additional employees at a later date.

To set up an employee’s personal information:

1. Click the **Employee Center** icon at the top of the QuickBooks Enterprise Solutions window.
2. Click **New Employee**.
3. On the **Personal** tab, fill in the form.
4. Click the **Address and Contact** tab, fill in the form and click OK.
5. When prompted to set up the employee’s payroll information, click **Leave As Is**.
♦ To set up an employee’s personal information:

1. Click the Employee Center icon at the top of the QuickBooks Enterprise Solutions window.

2. Click the Employees tab, select an employee from the list, and then double-click on the name.

3. From the Change tabs drop-down list, click Payroll and Compensation Info.

4. Fill in the Payroll Info form.

5. Click the Taxes button.

6. Click the Federal tab and fill in the form, based on the employee’s W-4 information.

7. Click the State tab and fill in the form.

8. Click OK.

After you have set up your employees, refer to Paying Employees on page 68 to learn about paying them.
Read this chapter to learn the following essential tasks.

- Creating an Estimate on page 56 describes how to create estimates.
- Creating an Invoice on page 58 describes how to create invoices.
- Entering Sales Receipts on page 59 describes how to enter sales receipts.
- Receiving Payments on page 60 describes how to receive payments.
- Making Deposits on page 61 describes how to make deposits.
Creating an Estimate

An estimate is a form you use to itemize the work you propose to do or the products you intend to sell to a customer. Your company might use a different term, such as bid, grant, or proposal. Estimates are optional, not mandatory, for all businesses.

You can use the estimate form to prepare estimates, bids, quotes, or proposals for your customers. You can change the title Estimate to anything that suits your business.

Filling in the estimate is similar to creating an invoice. And when it is time to bill your customer, you can create the invoice directly from the estimate by clicking Create Invoice on the estimate’s toolbar. Enterprise Solutions then creates the invoice, with all the information from the estimate filled in. Later, you can create reports that compare your estimated costs and revenue against your actual costs and revenue to see how accurate your estimates are.

Tip You can create sales orders to help you keep track of items that your customers have ordered but you have not yet delivered to them, for example because you do not have them in stock. Refer to the in-product Help for instructions and tips on how to use sales orders.

♦ To create an estimate:

1  Turn on the Estimates feature (described below), if you did not do this during the EasyStep Interview.
2  Go to the Customers menu and click Create Estimates.
3  In the Customer:Job box, enter the name of the customer or job.
4  Select an estimate template from the Template drop-down list.
5  Fill in the estimate form.
6  Click Print.
7  Save the estimate.
To turn on the estimates feature:

1. Go to the Edit menu and click Preferences.
2. Click Jobs & Estimates in the list on the left and then click the Company Preferences tab.
3. Click Yes to the question, Do You Create Estimates?
4. To display a warning when you try to record an estimate with the same number as the existing estimate, select the Warn about duplicate estimates numbers checkbox.
5. If you do progress invoicing (also known as progress billing or partial billing):
   - Make sure Yes is selected in response to the question, Do You Do Progress Invoicing?
   - Specify if you want line items that have zero amounts to print on your progress invoice.
6. Click OK.
Creating an Invoice

An invoice is the form you use to charge customers for the products and services they purchase from you. When your customers do not pay you in full at the time you provide your service or product, or when they pay in advance, you need to track how much they owe you. You can use an invoice to help you keep track of what your customers owe you (or your accounts receivable).

Invoices list all the details about the sale, including the services you are providing or the products you are selling (your items). Invoices also show the quantity and price or rate of each item. If you need to make automatic adjustments to prices (for example, discounts or markups), invoices will work for you.

If your customers pay in full at the time of purchase, do not create an invoice. Instead, create a sales receipt, described on page 59.

**To create an invoice:**

1. Go to the **Customers** menu and click **Create Invoices**.
2. From the **Customer:Job** drop-down list, enter or choose the name of the customer or job.
3. Click the **Template** drop-down arrow and then click the invoice template you want to use.
4. Click the **Terms** drop-down arrow and then click the sales terms that apply to this customer.
5. In the lower part of the form, enter each of the items (including the proper quantity) that the customer has purchased.
6. Click **Print** on the toolbar to print the invoice now. Optionally, you can select the **To be printed** checkbox to print the form later or the **To be e-mailed** checkbox to e-mail the form later.
7. Save the invoice.

**Tip** You can create an invoice letter directly from the invoice form by clicking the **Letters** button on the **Create Invoices** toolbar. Refer to the in-product Help for more detailed information about this feature.
You can customize your invoices (or any other sales form) for your business. Click Customize to open the Basic Customization window, where you can add your company logo, change fonts and colors, and access more advanced options.

**Entering Sales Receipts**

A sales receipt is the form you use when you make a sale for which you receive full payment at the time of the sale. Sales receipts can include payments by cash, check, or credit card.

When your customers pay in full at the time they receive your service or product, you do not need to track how much they owe you. However, you might want to record the sale, calculate its sales tax, or print a receipt for the sale. In these cases, you can create a sales receipt.

Examples of businesses that commonly use sales receipts include beauty salons, pet groomers, dry cleaners, and restaurants.

If you need to track how much a customer owes you or you do not receive full payment at the time of the transaction, do not use a sales receipt. Instead, create an invoice, described on page 58.

♦ **To enter a sales receipt:**

1. Go to the Customers menu and click Enter Sales Receipts.
2. Fill in the top part of the form, including the Customer:Job, Date, and Payment Method.
3. Click the Template drop-down arrow and then click the sales receipt template you want to use.
4. In the bottom part of the form, enter the items purchased.
5. Save the transaction.

**Tip**

You can also use a sales receipt to create a summary of sales income and sales tax owed. You can summarize daily or weekly sales on a sales receipt.
Receiving Payments

When you receive money from a customer, you must receive the payment in Enterprise Solutions so that you can record the transaction and mark the invoice as being paid. When you receive a payment, the accounts receivable records are updated, and the payment is ready to be deposited into an account.

✦ To receive a payment:

1. Go to the Customers menu and click Receive Payments.

2. Fill in the top portion of the form, including the customer’s name, the payment amount, payment method, and the date on which the payment was received.

3. Check the column to the left of the invoice to which you want to apply the payment. You might be asked to decide how to apply the payment for one of the following scenarios:
   - Overpayment can become a credit or refund
   - Underpayment can be left as is or written off
   - Customer has unused credit to be applied
   - Customer has available discounts

4. Choose the appropriate selection and you should see your choices reflected in total amounts for selected invoices.

   If the customer has a discount or available credits, you can choose how to apply them.

5. Save the payment.

Tip  You can set a preference so that payments received either go to the undeposited funds account automatically, or automatically get calculated and applied as you select invoices in the list. To set this preference, go to the Edit menu, click Preferences, and then click the Company Preferences tab in the Sales & Customers area.
Making Deposits

When you receive a payment from a customer, you can either deposit the payment into a bank account immediately, or you can wait until a later time to make the deposit.

♦ To make a deposit:

1. Go to the Banking menu and click Make Deposits.

2. In the Payments to Deposit window, select the payments that you want to deposit and click OK.

3. In the Make Deposits window, click the Deposit To drop-down arrow and then click the account to which you want to deposit the funds.

4. Verify the date and the list of payments to deposit, making updates as necessary.

5. If you want to receive cash back from this deposit, fill in the Cash Back fields at the bottom of the form.

6. If you want to print a deposit slip or deposit summary, click Print.

7. Save the deposit.

Note Just because you record the deposit in Enterprise Solutions does not mean that you actually make the deposit and that the money is available. You still need to physically deposit the money at the bank or send an online transfer.
Read this chapter to learn the following essential tasks:

- Paying Bills on page 64 describes how to pay bills.
- Writing Checks on page 66 describes how to write checks.
- Issuing Credits or Refunds on page 67 describes how to issue credits or refunds.
- Paying Employees on page 68 describes how to pay employees.
Paying Bills

As you purchase equipment, supplies, products, or services to run your business, you will also receive bills that need to be paid. Entering these bills in Enterprise Solutions enables you to not only track information about your purchases, but also to pay these bills. Enterprise Solutions remembers all of your unpaid bills, enabling you to easily choose the bills you want to pay. Enterprise Solutions then writes and saves the checks or credit card charges or sends the online banking payment instructions, depending on the payment method you choose.

♦ To enter a bill:

1. Go to the Vendors menu and click Enter Bills.
2. In the Vendor field, choose or enter a new vendor.
   Note: If an open purchase order exists for this vendor, you are prompted to receive against it. Click Yes to receive against one or more purchase orders; then, in the Open Purchase Orders window, click each purchase order that contains items you have received and are being billed for.
3. Specify the payment method, payment account, and payment date.
4. In the Amount Due field, enter the amount of the bill.
5. Fill in the Date, Ref. No., Terms, and Memo fields as necessary.
6. For expenses (money you spend to run your business, such as utilities), assign the bill to one or more expense accounts in the Expenses tab.
   For items (products or services your business buys), edit items that were entered from your purchase order or enter new items on the Items tab.
7. Click Save & Close or Save & New to enter the transaction.
To pay a bill:

1. Go to the Vendors menu and click Pay Bills.
2. All outstanding bills are displayed. To limit the number of bills displayed, click Due on or before and then the due date for the bills you want to display.
3. Click Pay Selected Bills to complete the transaction.

Tip: You do not need to use the Pay Bills window to pay your bills. You can enter checks, credit card payments, and cash expenditures directly in the appropriate account register. However, if you enter bills using either the Enter Bills window or the Accounts Payable register, you must use the Pay Bills window for your bill payment. Do not use the Write Checks window to pay a bill that you have entered with either of these methods.
Writing Checks

You can write a check for any kind of expense that you track with Enterprise Solutions expense accounts and for non-inventory part, service, and other charge items. If you are using inventory or purchase orders, you can write checks for inventory part items too.

Note Before writing a check read the section Writing Checks Versus Paying Bills on page 21 to make sure you are using the correct payment method.

Important Do not use the Write Checks window to write a paycheck, pay your payroll liabilities, pay sales tax, or pay bills you have already entered in the Pay Bills window.

♦ To write a check:

1. Go to the Banking menu and click Write Checks.
2. Click the Bank Account drop-down arrow and then click the account from which you want to write the check.
3. Fill in the on-screen check as you would a paper check.
4. Itemize your expenses (shipping charges, taxes, or other expenses not associated with any one item) on the Expenses tab.
5. If you are purchasing items for your inventory, enter the items on the Items tab.
6. Save the transaction.

♦ To find and print a single check:

1. Load the blank check form into the printer.
2. Go to the Banking menu and click Write Checks.
3. Click the Find button and search for the check you want to print.
4. Double-click to view the check you want to print.
5. Click Print.
6. In the Print Checks window, choose the options you want and click Print.
Issuing Credits or Refunds

Use a credit memo to record a credit when a customer returns items and you have already recorded an invoice, customer payment, or sales receipt. You can also use a credit memo for an overpayment. A credit memo is a document that notifies a customer that you have reduced the customer’s balance (for example, when a customer cancels a sale, returns something, or overpays).

To enter a credit memo or record a return:

1. Go to the Customers menu and click Create Credit Memos/Refunds.
2. In the Customer:Job field, click the customer and job for which you are creating the credit memo or refund check.
   
   **Note:** If you have created more than one job for the customer, be sure to assign the credit memo to the correct job. You can apply the credit memo only to the same job for which it was created.
3. Click the Template drop-down arrow and then click a template.
4. Enter the items being returned in the line item area.
5. Describe the reason for the credit and enter the quality and rate, if applicable.
6. (Optional) Enter a memo for this transaction.
   
   **Note:** The memo does not print on the credit memo, but it does appear in the Accounts Receivable and the customer registers.
7. Indicate whether you want to print or e-mail the credit memo to the customer. (You can choose to do both.)
8. Save the credit memo.
9. In the Available Credit window, choose how to use the credit:
   
   - Retain as an available credit

---

**Note**
To learn how to print multiple checks at the same time, refer to the in-product Help.
Give a refund

Apply it to an invoice

Note: Enterprise Solutions enters a negative amount in your Accounts Receivable register for the credit memo.

---

**Paying Employees**

Paying employees is a big responsibility. You have to keep track of hours, salaries and wages, Social Security numbers and dependents, tax rates and forms, vacation and sick time, bonuses and advances, as well as company payments to government and private pension plans. Enterprise Solutions provides several features and services to help you manage your own payroll quickly and easily.

Tip: Always use the Pay Employees window to record paychecks. Enterprise Solutions payroll tax forms and reports take their data from transactions recorded as payroll items. These transactions are only created when you create a paycheck in the Pay Employees window. If you do not use this window to pay employees, your payroll tax forms and reports will not be complete.

Note: Some payroll tasks require you to subscribe to one of the Intuit Payroll Services. Enterprise Solutions cannot calculate payroll taxes unless you sign up for a payroll service. For information about your payroll options, go to the Employees menu, click Payroll and then click Learn About Payroll Options.

To print paychecks:

1. Go to the Employees menu and click Pay Employees. Specify if you want to pay employees using Unscheduled Payroll (generally used to pay bonuses and off-cycle checks) or set up Payroll Schedules.
2. Update the Pay Period Ends date and the Check Date values, as needed.
3. Click the Bank Account drop-down arrow to choose the account that Enterprise Solutions uses to record this transaction.
4 Select the employees you want to pay by clicking in the column to the left of the employee’s name.

5 Review the paycheck information in the Enter Payroll Information window.

6 To preview or modify a paycheck, click the employee’s name to open the Preview Paycheck window. Make the necessary changes and click Done.

7 Click Continue.

8 Review and verify the paycheck information in the Review and Create [or Save] Paychecks window.

9 If an employee is already set up for direct deposit, select the Direct Deposit checkbox in the same line as the employee.

10 In the Payment Options section, click whether the paychecks should be printed or handwritten.

11 Click Create Paychecks.

12 In the Confirmation and Next Steps window, click Print Paychecks. Click Send Payroll to Intuit if you are sending your payroll to Intuit for processing.

Intuit Payroll Services

Intuit offers a variety of payroll services to meet your needs:

- **Basic Payroll** includes tools and tax tables to help you efficiently run your payroll and pay your payroll taxes. (Basic Payroll does not include payroll tax forms.)

- **Enhanced Payroll** adds state tax forms, tools for tracking workers compensation costs, and tools for easily calculating bonuses. You can process payroll for up to three business entities (EINs).

- **Enhanced Payroll for Accountants** includes the Enhanced Payroll features, plus after-the-fact payroll, client-ready reports, and the ability to process payroll for up to 50 specific businesses.

- **Assisted Payroll** - Intuit handles your tax payment and filings for you.
All payroll services offer direct deposit of employee paychecks for a small additional fee.

For more information about payroll services, go to the Employees menu and click Add Payroll Service.
Managing Your Business

Read this chapter to learn essential tasks for managing your business.

- **Using Reports on page 72** describes how to create and use reports.
- **Additional Services and Solutions on page 76** describes how to streamline business management and automate business activities with additional services and solutions from Intuit.
- **Integrated Business Software on page 77** describes how to grow your business by solving business challenges with industry-specific software that expands the functionality of your Enterprise Solutions software.
Using Reports

Everything you enter in Enterprise Solutions can be found and generated into a report. Enterprise Solutions comes with dozens of prepared reports that you can run. You can use the Report Center to learn about reports and locate the ones that contain the information you need. After you have found a report, you can change its date range, customize the way it looks, print a copy of it, export it to Microsoft Excel, or display it on your screen.

♦ To find and display the right report:

1. Click the Report Center icon at the top of the QuickBooks Enterprise Solutions window.
2. Click a report category from the list on the left. Reports for the selected category are displayed on the right.
3. You can view more sample reports by clicking the report on the left or right of the center report. Click the question mark icon to learn about the data and specific ways to customize the report.
4. When you find the report you need, click the thumbnail report icon at the bottom of the screen to view the report.

In addition to the powerful reports available in the Report Center, you can also use the QuickBooks Centers to get a quick snapshot of how your business is doing and the status of your relationships with your customers, vendors, and employees. For example, from the Centers you can easily see all of your unpaid bills, all of the invoices that your customers have not paid, and the detailed history of each of your customers and vendors. For more information about the QuickBooks Centers, refer to page 10 or see the in-product Help.

The Report Center describes all the available reports. Table 5 lists 10 common questions that people ask and the QuickBooks report you can use to find the answer.

<table>
<thead>
<tr>
<th>To Answer This Question</th>
<th>Use This Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>How much money did my company make or lose over a specific period of time?</td>
<td>Profit &amp; Loss Standard (In Company &amp; Financial)</td>
</tr>
</tbody>
</table>
### To Answer This Question

<table>
<thead>
<tr>
<th>Question</th>
<th>Use This Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which invoices or statement charges have not been paid and when are they due?</td>
<td><strong>A/R Aging Detail</strong> (In Customers &amp; Receivables)</td>
</tr>
<tr>
<td>How much does my company owe each vendor and are any payments overdue?</td>
<td><strong>A/P Aging Detail</strong> (In Vendors &amp; Payables)</td>
</tr>
<tr>
<td>What is the value of my company (assets, liabilities, and equity), and where can I see the total balance for each type of account?</td>
<td><strong>Balance Sheet Summary</strong> (In Company &amp; Financial)</td>
</tr>
<tr>
<td>What is the recent activity in all my company’s accounts, with beginning and ending balances for each account?</td>
<td><strong>General Ledger</strong> (In Accountant &amp; Taxes)</td>
</tr>
<tr>
<td>What are the total sales for each customer and job?</td>
<td><strong>Sales by Customer Summary</strong> (In Sales)</td>
</tr>
<tr>
<td>Which items and/or services bring in the most/least income?</td>
<td><strong>Sales by Item Summary</strong> (In Sales)</td>
</tr>
<tr>
<td>What are my company’s total expenses for each vendor?</td>
<td><strong>Expenses by Vendor Summary</strong> (In Company &amp; Financial)</td>
</tr>
<tr>
<td>Where is the information I need for my federal income tax forms?</td>
<td><strong>Income Tax Summary Income Tax Detail</strong> (In Accountant &amp; Taxes)</td>
</tr>
<tr>
<td>For my company’s total sales, how much is taxable, at what rate, and how much sales tax is currently due to be paid?</td>
<td><strong>Sales Tax Liability</strong> (In Vendors &amp; Payables)</td>
</tr>
</tbody>
</table>

**Table 5  Reports**

## Memorizing a Report

Whenever you change the settings for a report (modify it), you can memorize the report with the new settings and save it in the Memorized Report List. When you want to create a similar report, you can click the Memorized Report List to find it.

**Note**

Enterprise Solutions memorizes the report settings, not the data in the report. When you display a memorized report, it applies the settings you memorized, but displays the latest data. For example, if the report date is
set for the period Last Month and you memorize the report in September but recall it in December, the recalled report will have data for November, not August.

♦ **To memorize a report:**

1. Click the Report Center icon at the top of the QuickBooks Enterprise Solutions window.
2. Open the report you want to modify and save.
3. After you have customized a report, click **Memorize** at the top of the report.
4. If you have changed an existing memorized report, indicate whether you want to replace the earlier report (under the same name) or create a new memorized report (under a new name).
5. In the **Memorize Report** window, enter a title for the report.
6. If you want to assign the report to a memorized report group, choose **Save in Memorized Report Group** and choose the group from the drop-down list. (You must already have the group set up on your **Memorized Report List**. You cannot create a new group here.)
7. Click **OK**.
Customizing a Report

Enterprise Solutions provides many preset reports that focus on all aspects of your business finances. However, you might want to change the way the data displays or filter the report for specific information. To get the most out of your reports, you can:

- Change the data range of a report
- Change the scope of a report
- Modify the appearance of a report (changing fonts or columns widths)

To learn how to get the most out of your reports, go to the Report Center and then click the Learning link in the top-left corner of the window.
Additional Services and Solutions

QuickBooks Business Services enable you to streamline management of your business and automate essential business activities.

Intuit provides the following Business Services and Software (each sold separately). To learn more about these business solutions, go to the Help menu and click Add QuickBooks Services.

- QuickBooks Online Banking
- QuickBooks Bill Pay Service
- QuickBooks Deluxe Online Billing Service
- QuickBooks Remote Access
- QuickBooks Online Backup Service
- QuickBooks Merchant Account Service
- QuickBooks Technical Support Plan
- QuickBooks Checks and Supplies
- QuickBooks Employee Organizer
- QuickBooks Standard Payroll
- QuickBooks Enhanced Payroll
- QuickBooks Assisted Payroll Service
- QuickBooks Enhanced Payroll for Accountants
- QuickBooks Point of Sale software or hardware
- QuickBooks Platinum Plus Business Mastercard
- QuickBooks Customer Manager software
- QuickBooks Client Manager software
- Warehouse Management Enterprise Solutions
- Field Service Management Enterprise Solutions
Integrated Business Software

Grow your business by solving unique business challenges with tested, industry-specific software applications that expand the power and functionality of your QuickBooks Enterprise Solutions software. Work anytime, anywhere and still access your data using these tested third-party solutions that integrate with Enterprise Solutions and help streamline critical business operations.

Created by credible, independent Intuit Gold and Silver Developers with extensive industry expertise, these task-based applications work together with your Enterprise Solutions, offering you a comprehensive solution that helps you build and better manage your business. Sample industries and key workflows served by these third-party applications include:

- **Construction** — Work more efficiently when doing complex estimating, project management, scheduling, and more.

- **Manufacturing** — Streamline business operations including shop floor management, advanced inventory and order management. Find applications that help you better manage your customers and EDI.

- **Nonprofit** — Run your organization more efficiently through advanced donor management and fund accounting. Track grants, program costs, and donor information.

- **Professional Services** — Strengthen the management of your firm, including better control over client information, billing rates, project management, and customized invoicing.

- **Retail** — Increase the efficiency of your retail business and spend more time with your customers through better inventory management, support for your point of sale transactions, and improved e-commerce efforts.

- **Wholesale and Distribution** — Gain greater control over your business with automating route delivery, sales commission tracking, EDI, and more.

Frequently Asked Questions

How do I register my copy of Enterprise Solutions?

You can register online or by phone. Go to the Help menu and click Register QuickBooks.

How do I contact Technical Support?

Go to the QuickBooks Support website at www.qbes.com/support. Refer to Technical Support on page 5.

How do I purchase additional user licenses?

Enterprise Solutions allows multiple users to access the company file at the same time. As your company grows, you can add additional licenses instead of purchasing additional copies of Enterprise Solutions.

To add a license to your existing Enterprise Solutions license, go to the Help menu, click Manage My License, click Buy Additional User Licenses and then follow the onscreen instructions.
How do I move my company file from one computer to another?

To move company files from one computer to another, Intuit recommends that you use a portable company file. The portable company file does not simply copy the data for your company; it compresses the data into a smaller file.

♦ To move your company file:

1  Create a portable company file on the source computer:
   a  Go to the File menu and click Save Copy or Backup.
   b  Click Portable company file and then click Next.
   c  Select the drive (hard drive, CD, or ZIP disk) where you want to save the portable company file. You can use the same filename or enter a new name.
   d  Click Save.

2  Take the media containing your portable company file to the computer to which you want to move your company file.

3  Open the portable company file on the destination computer:
   a  Go to the File menu and click Open or Restore Company.
   b  Click Restore a portable file and click Next.
   c  Browse to select the portable company file you want to restore, click Open, and then click Next.
   d  Browse to select and change the location and file name of the company file that will be created and opened from the portable company file. If you select an existing company file, it will be overwritten with the data from the portable company file.
   e  Click Save.
How do I remove older or unneeded transactions from my data file?

You can use the **Clean Up Company Data** utility to remove transactions for which you no longer need to keep detailed records. You can choose to remove transactions as of a specific date (for example, all transactions date on or before 12/31/04). Optionally, you can choose to remove unused list items, such as obsolete customers and items.

Before removing the transactions, Enterprise Solutions creates an archive copy of your company file and enters general journal transactions that summarize the transactions being removed.

**To remove older or unneeded transactions:**

1. Go to the **File** menu, click **Utilities**, and then click **Clean Up Company Data**.
2. Select one of the options:
   - To remove transactions as of a specific date, click **Remove transactions as of a specific date** and then select the date from the date box.
   - To remove all transactions in the file, click **Remove ALL transactions**.
3. Click **Next** and follow the onscreen instructions.

*Note* Cleaning up the data in the company file does not reduce the physical size of the company file.
How do I download and install an update or patch?

Periodically, Intuit provides updates to QuickBooks Enterprise Solutions that you can download from the Internet. These updates might include maintenance fixes and new Help information.

To download an update, go to the Help menu and click Update QuickBooks. Follow the onscreen instructions.

Note

If you store your company file on a file server and also installed the Enterprise Solutions application on that server, you need to periodically run Enterprise Solutions on the server and apply patches and updates.

How do I back up or restore my company file?

Back up your company files daily. Backup copies are important insurance; if you should lose data for any reason, you can restore data from your backup copy. Enterprise Solutions enables you to back up and restore your data in a number of ways.

♦ To backup a company file:

1. Go to the File menu and click Save Copy or Backup.
2. Choose the backup option you want, click Next, and follow the onscreen instructions.

♦ To restore a company file:

1. Go to the File menu and click Open or Restore Company.
2. Choose the restore option you want, click Next, and follow the onscreen instructions.

To view detailed instructions for each backup and restore option, refer to the in-product Help.
What should I do if I forget my password?

QuickBooks 2004 and later releases support case-sensitive passwords. If you believe you are entering the correct password but still get the message The password you typed is incorrect, your password might include mixed-cased characters. Try the following solutions:

- Enter Admin and then click OK without typing a password.
- Enter your password with Caps Lock or Num Lock turned on or off.
- Enter variations of your password, using mixed upper- and lower-case characters.
- Enter the password with a space before or after the actual password.
- Type the password in a text editor, such as WordPad or NotePad, to confirm that your keyboard is functioning properly.
- Restore a pre-update backup of your file that does not have the case-sensitive password. When you restore this file, you can set your new administrator password at the end of the update process.

If you are still unable to access your file, go to the Password Recovery website: www.qbes.com/passwordremoval (additional fees may apply).

Note: Be sure to write down and save your administrator password in a secure place. Passwords not only protect your company data, but are also required to access your company file if you upgrade your version of Enterprise Solutions.
How do I update my payroll to use the latest tax tables?

If you are a QuickBooks Payroll subscriber, you have two options for updating your tax tables:

- Go to the Employees menu, click Get Payroll Updates, and then click Update.
- Turn on the Auto-update preference. When a new tax table is available, it is downloaded automatically and you are prompted to install.

Payroll updates, which might include compliance enhancements and updated payroll tax forms as well as new tax tables, become available throughout the year. We recommend that you connect to the payroll service at least every 45 days to make sure you have the most current tax table available.

*Important:* Make sure that you download and install the latest payroll update before you pay employees for the first time.

How do I add another company’s EIN to existing Payroll subscription?

- To add an EIN for another company:
  1. Go to the File menu and click Open or Restore Company. Click Open a company file and then click Next. Choose the company file you want to add and click Open.
  2. Go to the Employees menu, click Payroll Service Activities, and then click Use my existing Payroll subscription. When asked if you want help setting up payroll, click Yes.
  3. Click Add To Subscription and click Next.
  4. Enter and confirm the new EIN to be associated with your existing subscription.
  5. Click Done.

Enterprise Solutions updates your subscription in the new company file. You can run payroll immediately.
Note  QuickBooks Standard and Enhanced payroll subscriptions can process payroll for up to three businesses (EINs) on the same payroll subscription. QuickBooks Enhanced Payroll for Accountants can process payroll for up to 50 EINs on the same payroll subscription.
Table 6 provides the keyboard shortcuts you can use to perform tasks quickly.

<table>
<thead>
<tr>
<th>Keyboard Shortcuts</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
</tr>
<tr>
<td>To start QuickBooks without a company file</td>
<td>Ctrl (while opening)</td>
</tr>
<tr>
<td>To suppress the desktop windows (in the Open Company window)</td>
<td>Alt (while opening)</td>
</tr>
<tr>
<td>Display product information about your software version</td>
<td>Ctrl + 2</td>
</tr>
<tr>
<td>Close active window</td>
<td>Esc or Ctrl + F4</td>
</tr>
<tr>
<td>Active button (any button that has the black or colored selection border around it )</td>
<td>Enter</td>
</tr>
<tr>
<td>Save (will always perform the <strong>Record, OK, or Save and New</strong> action)</td>
<td>Ctrl + Enter</td>
</tr>
<tr>
<td><strong>Dates</strong></td>
<td></td>
</tr>
<tr>
<td>Next day</td>
<td>+ (plus key)</td>
</tr>
<tr>
<td>Previous day</td>
<td>- (minus key)</td>
</tr>
<tr>
<td>Today</td>
<td>T</td>
</tr>
<tr>
<td>First day of the week</td>
<td>W</td>
</tr>
<tr>
<td>Last day of the week</td>
<td>K</td>
</tr>
<tr>
<td>First day of the month</td>
<td>M</td>
</tr>
<tr>
<td>Last day of the month</td>
<td>H</td>
</tr>
</tbody>
</table>
### Keyboard Shortcuts

<table>
<thead>
<tr>
<th>First day of the year</th>
<th>Y</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last day of the year</td>
<td>R</td>
</tr>
<tr>
<td>Date calendar</td>
<td>Alt + (down arrow)</td>
</tr>
</tbody>
</table>

#### Editing

<table>
<thead>
<tr>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit transaction selected in register or lift</td>
</tr>
<tr>
<td>Delete character to right of insertion point</td>
</tr>
<tr>
<td>Delete character to left of insertion point</td>
</tr>
<tr>
<td>Delete line from detail area</td>
</tr>
<tr>
<td>Insert line in detail area</td>
</tr>
<tr>
<td>Cut selected characters</td>
</tr>
<tr>
<td>Copy selected characters</td>
</tr>
<tr>
<td>Paste cut or copied characters</td>
</tr>
<tr>
<td>Increase check or other form number by one</td>
</tr>
<tr>
<td>Decrease check or other form number by one</td>
</tr>
<tr>
<td>Undo changes made in field</td>
</tr>
</tbody>
</table>

#### Help Window

<table>
<thead>
<tr>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display Help in context</td>
</tr>
<tr>
<td>Go to next Help topic</td>
</tr>
<tr>
<td>Got to previous Help topic</td>
</tr>
<tr>
<td>Display selected topic</td>
</tr>
</tbody>
</table>

#### Activity

<table>
<thead>
<tr>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy check transaction in register</td>
</tr>
<tr>
<td>Create invoice</td>
</tr>
<tr>
<td>Delete check, invoice, transaction, or item from list</td>
</tr>
<tr>
<td>Keyboard Shortcuts</td>
</tr>
<tr>
<td>------------------------------------------------------</td>
</tr>
<tr>
<td>Find transaction</td>
</tr>
<tr>
<td>Go to register of transfer account</td>
</tr>
<tr>
<td>History of A/R or A/P transaction</td>
</tr>
<tr>
<td>Memorize transaction or report</td>
</tr>
<tr>
<td>New invoice, bill, check or list item in context</td>
</tr>
<tr>
<td>Open account list</td>
</tr>
<tr>
<td>Open Customer Center (Customers &amp; Job list)</td>
</tr>
<tr>
<td>Open Help for active window</td>
</tr>
<tr>
<td>Open list (for current drop-down menu)</td>
</tr>
<tr>
<td>Open memorized transaction list</td>
</tr>
<tr>
<td>Open split transaction window in register</td>
</tr>
<tr>
<td>Open transaction journal</td>
</tr>
<tr>
<td>Paste copied transaction in register</td>
</tr>
<tr>
<td>Print</td>
</tr>
<tr>
<td>QuickReport on transaction or list item</td>
</tr>
<tr>
<td>QuickZoom on report</td>
</tr>
<tr>
<td>Show list</td>
</tr>
<tr>
<td>Use list item</td>
</tr>
<tr>
<td>Write new check</td>
</tr>
<tr>
<td><strong>Moving Around a Window</strong></td>
</tr>
<tr>
<td>Next field</td>
</tr>
<tr>
<td>Previous field</td>
</tr>
<tr>
<td>Beginning of current field</td>
</tr>
<tr>
<td>End of current field</td>
</tr>
<tr>
<td><strong>Keyboard Shortcuts</strong></td>
</tr>
<tr>
<td>-----------------------------------------------------------</td>
</tr>
<tr>
<td>Line below in detail area or on report</td>
</tr>
<tr>
<td>Line above in detail area or on report</td>
</tr>
<tr>
<td>Down one screen</td>
</tr>
<tr>
<td>Up one screen</td>
</tr>
<tr>
<td>Next word in field</td>
</tr>
<tr>
<td>Previous word in field</td>
</tr>
<tr>
<td>First item on list or previous month in register</td>
</tr>
<tr>
<td>Last item on list or next month in register</td>
</tr>
<tr>
<td>Close active window</td>
</tr>
</tbody>
</table>

**Table 6  **Keyboard Shortcuts
Index

A
Account types 29
Adding
accounts 28
customers 33
EIN for another company 84
icons to the icon bar 13
items 36
vendors 35
Additional services and solutions 76
Additional user licenses 79
Assisted Payroll 69

B
Backing up company files 82
Balance sheet accounts 31
Basic Payroll 69

C
Choosing a payroll service 49
Coach 9, 18
Creating
estimates 56
invoices 58
Credit memo 67
Credits 67
Currencies 22
Customer Center 10
Customizing Enterprise Solutions 26

D
Displaying multiple windows 12

E
EIN 11
adding for another company 84
Employee Center 11
Enhanced Payroll 69
Enhanced Payroll for Accountants 69
Entering bills 21
Expense accounts 30

G
Getting around 8

H
Home page 8

I
Icons, adding 13
Income accounts 30
In-product Help 15
Integrated Business Software 77
Intuit payroll services 69
Intuit Solution Providers 14
Issuing credits or refunds 67

L
Learning Center 18
List information 21
Live Community 19
Local help 14
M
Making deposits 61
Moving company files 80
Multiple currencies 22

N
New accounts 29

P
Passwords 83
Patches 82
Paying
  bills 64
  employees 68
Payroll Center 11
Payroll services 69
Preparing payroll information 50

Q
QuickBooks Centers 10
QuickBooks Coach 9, 18

R
Receiving a payment 60
Refunds 67
Removing unneeded transactions 81
Reports 72

S
Sales receipts 59
Sales tax
  codes 40, 45
  payment schedule 44
  preferences 43
Sample company files 23
Setting preferences 26

Setting up
  employees 52
  payroll 49
  sales tax 40
Solution Providers 14
Subaccounts 29

T
Tax agencies 46
Technical Support 5
Third-party applications 71, 77
Transactions, removing 81
Tutorials 18

U
Updates 82
User Community 5
User licenses 79
Using Help Search 17
Using reports 72

V
Vendor Center 11

W
Writing checks 21, 66